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Uvod 

Risovi (Lynx) su rod iz porodice mačaka (Felidae) svrstani u četiri vrste: euroazijski 

ris (Lynx lynx), kanadski ris (Lynx canadensis), Iberijski ris (Lynx pardina) i crveni ris (Lynx 

rufus) (GARMS, 1981). Euroazijski ris je do 16. stoljeća naseljavao gotovo cijelu Aziju i 

Europu (osim Španjolske i Portugala gdje živi Iberijski ris), no već tada počinje pad brojnosti 

risjih populacija, što dostiže svoj vrhunac tijekom 19. stoljeća. Današnja slika 

rasprostranjenosti risa u Europi rezultat je međunarodne zaštite i više projekata reintrodukcije. 

Životinje su tijekom 1970-ih iz slovačkih Karpata naseljene u 10 zemalja na 14 lokacija, no 

tek je manji dio tih projekata bio uspješan. Jednom od najuspješnijih reintrodukcija smatra se 

ona u Dinaride kojom je nastala populacija koja živi na području Slovenije, Hrvatske te Bosne 

i Hercegovine. Danas se autohtone populacije risa u Skandinaviji, na Baltiku (Latvija, 

Estonija), Karpatima i Rusiji smatraju stabilnima, te se na većem djelu staništa provodi lovno 

gospodarenje. U Poljskoj, Litvi i Bjelorusiji ris je prisutan u više malih, međusobno izoliranih 

jezgri, što predstavlja prijetnju opstanku populacije na tom području. Balkanska populacija 

preživjela je jedino na izoliranom graničnom području između Makedonije i Albanije, te se 

smatra da tamo danas živi najviše 50 do 60 životinja kojima zbog gubitka staništa, nedostatka 

plijena i krivolova prijeti izumiranje. Danas, 40 godina nakon naseljavanja, svim 

reintroduciranim populacijama risa u Europi prijeti izumiranje, prvenstveno onim u 

Švicarskim Alpama i Jura planinama, te u Dinaridima prijeti ponovno izumiranje. Najvažniji 

razlog je gubitak genske raznolikosti zbog malog broja osnivača, te međusobna izoliranost, 

što je dovelo do parenja u srodstvu (SINDIČIĆ, 2010). 

 

Sistematika 

Carstvo: Animalia 

Koljeno: Chordata 

Razred: Mammalia 

Red: Carnivora 

Porodica: Felidae 

Rod: Lynx 

Vrsta: Lynx lynx. 

rkf 
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Pripadnici porodice mačaka (Felidae) imaju različite uzorke krzna, te se prema obliku i 

karakteristikama krzno može svrstati u šest kategorija: jednolično (engl. uniform), točkasto 

(engl. flecks), rozetasto (engl. rosettes), poprečno isprugano (engl. vertical stripes) i krzno s 

velikim i malim mrljama (engl. blotches) (WERDELIN i OLSSON, 1997). Iako je nepoznat 

točan mehanizam nastanka različitih varijacija krzna THÜLER (2002) smatra se da je prvotni 

tip krzna kod mačaka bio obilježen samo velikim točkama, od kojih su se tokom evolucije 

razvili navedeni različiti uzorci (WEIGEL, 1961). Kod euroazijskog risa (Lynx lynx) na krznu 

se uglavnom pojavljuju uzorci u obliku točki, koje mogu biti različitog oblika i veličine. 

Prema tome kod risa se može razlikovati krzno bez točki, krzno s malim točkama, velikim 

točkama, te krzno s rozetama za koje se smatra da je evolucijom nastalo od prethodna dva tipa 

krzna (GREGOROVA, 1997). 

Promjene u učestalosti pojedinog tipa krzna u populaciji mogu biti jedan od 

pokazatelja genske raznolikosti te populacije. Istraživanja u Švicarskoj na populaciji risa iz 

Jura planina i Alpskoj populaciji, koje su reintroducirane iz slovačkih Karpata, pokazala su da 

postoji smanjena raznolikost u tipovima krzna u odnosu na izvornu karpatsku populaciju, 

odnosno da je tip krzna bez točki u potpunosti iščeznuo u Jurskoj populaciji. Iz svega 

navedenog moglo se pretpostaviti da su navedene populacije bile izložene genskom otklonu 

(driftu) (THÜLER, 2002). Kod genskog otklona neki aleli mogu u potpunosti nestati iz 

genske baze populacije, čime se smanjuje genska raznolikost, a time i raznolikost određenih 

svojstava kojim geni upravljaju (RAVEN i sur., 2005). Takvoj pojavi posebno su izložene 

populacije koje su bile izložene učinku uskog grla, što je slučaj kod risova koji su iz slovačkih 

Karpata reintroducirani u Švicarsku, a kasnije u Sloveniju i Hrvatsku (dinarska populacija). 

Ris je u Hrvatsku reintroduciran 1973. godine, sedamdeset godina nakon što je u potpunosti 

istrijebljen. Današnja populacija risa u Dinaridima razvila se od šest jedinki reintroduciranih s 

Karpata (tri mužjaka i tri ženke). Iz navedene činjenice se može zaključiti da se radi o vrlo 

maloj genskoj bazi, a time i velikoj mogućnosti ostvarenja već spomenutog genskog otklona 

kao posljedice osnivačkog učinka (GOMERČIĆ, 2010). Dinarsku populaciju risa koju 

Hrvatska dijeli sa Slovenijom te Bosnom i Hercegovinom, danas čini najviše 130 jedinki. 

Populacija je malena i ugrožena, a uz krivolov i nisku gustoću populacije plijena smanjena 

genska raznolikost je također značajna prijetnja njenom opstanku (SINDIČIĆ, 2013).  

Autohtoni ris koji je živio na području Hrvatske do 1903. godine još obitava u 

izoliranim područjima balkanskog poluotoka - Albanija, Makedonija, Kosovo (GOMERČIĆ, 

2010). O autohtonoj populaciji balkanskog risa ne postoji puno znanstvenih podataka. MIRIĆ 

(1978) opisuje različite tipove krzna koji se pojavljuju kod balkanskog risa: krzno s velikim 
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točkama (jasno vidljive, rijetko raspoređene), krzno s malim gusto zbijenim točkama, te krzno 

bez točki po leđima i bokovima.  

 

Materijal i metode 

Istraživanje je provedeno na ukupno 95 fotografija risova iz Hrvatske koji su legalno 

odstrijeljeni u razdoblju od 1980. do 1994. godine. Krzna su fotografirana u domaćinstvima 

lovaca, lovačkim kućama i planinarskim domovima na području Gorskog kotara i Like. Dio 

fotografija je dobiven skeniranjem dijapozitiva dipl. inž. Alojzija Frkovića, dok je veći dio 

krzna fotografiran digitalnim fotoaparatom. Od ukupno 95 uzoraka, njih 91 su preparirana 

trofejna krzna, dok se u četiri slučaja radilo o cijelim prepariranim životinjama. Za 24 jedinke 

risa bila je poznata dob (GOMERČIĆ, 2004) koja je određena metodom brojanja linija u 

zubnom cementu. 

Prema GREGOROVA (1997) risja krzna podijeljena su na osnovu uzoraka pjega i 

rozeta (nepravilni oblici sa svjetlijom sredinom i tamnijim rubom) u četiri tipa. Na krznu tipa 

1 dominiraju velike crne upečatljive pjege, koje se javljaju u različitim pravilnim i 

nepravilnim oblicima. Krzno tipa 2 ispunjeno je sitnijim pjegama čiji oblici dosta variraju i 

većinom su nepravilni. Krzno tipa 3 nema vidljivih uzoraka u vidu pjega, osim na distalnim 

dijelovima nogu i butu, dok se rozete kod nekih mogu zamijetiti, ali su jako slabo izražene, pa 

takav primjer ostavlja dojam jednoličnog krzna bez ikakvih uzoraka. Vidljive rozete koje se 

pružaju skroz od vrata, preko trupa do područja nogu gdje većinom prelaze u blijede pjege 

specifične su za krzno tipa 4. Nakon što je izabran reprezentativni primjerak za svaki od četiri 

tipa krzna (Slika 1), prema njima su sva krzna svrstana u navedene skupine. Zatim je svako 

krzno podijeljeno u šest područja: lijevo i desno rame (nadlaktica i podlaktica), lijevi i desni 

dio trupa, te lijevi i desni but s potkoljenicom i na svakom krznu je određena gustoća i 

raspored točaka. 

Za obradu i analizu podataka korišteni su programi Microsoft Office Excel 2007, 

Picasa3, Statistica 7 i ImageJ 1.47a (SCHNEIDER i sur. 2012). 

Nakon što su po opisanom modelu krzna podijeljena u navedene kategorije (tipove), 

rezultati su uspoređeni s poznatom dobi životinja s ciljem utvrđivanja povezanosti pojedinih 

tipova krzna s određenom dobnom skupinom. Dobne skupine su određene na način da su sve 

životinje do 4 godine svrstane u mladu dobnu kategoriju, od 4 do 7 godina u srednju, a od 7 

godina na dalje u stariju dobnu kategoriju. Dobiveni rezultati za udio pojedinih tipova krzna u 

hrvatskoj populaciji su uspoređeni s poznatim rezultatima za populacije risova u švicarskim 

Alpama, švicarskim Jura planinama, te u slovačkim karpatima. 
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Slika 1. Tipovi risjeg krzna. a) Tip1 (velike točke), b) Tip 2 (male točke), c) Tip 3 (bez točki), 

d) Tip 4 (rozete) 

 

Upotrebom računalnog programa ImageJ (SCHNEIDERi sur., 2012) za svako krzno 

dobiven je udio crnih površina, broj točaka, gustoća točaka na prednjoj nozi, trupu i stražnjoj 

nozi te ukupno na jednoj strani krzna.  

 

Protokol za obradu fotografija krzna risa: 

Svaka fotografija je otvorena u programu ImageJ. 

komanda: File->Open 

Kako su sve fotografije bile u boji konvertirane su u crno bijele (32 bita). 

komanda: Image->Type->32-bit 

Na fotografijama nije postojala mjerna skala tako da je mjerna jedinica piksela 

određena kao 1000ti dio duljine od početka repa do sredine između lopatica. 

komanda: izabrati liniju (Straight) i povući je od početka repa do točke između 

lopatica 

komanda: Analyze->Set Scale->Known distance staviti 1000 (Slika 2). 
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Slika 2. Kalibriranje veličine piksela kao 1000ti dio udaljenosti od početka repa do linije 

između lopatica 

 

Određena su područja istraživanja (ROI-region of interest) i to posebno za prednju 

nogu, trup i stražnju nogu.(Slika 3). 

komanda: pomoću (Polygon selections) definirana su 3 područja promatranja (ROI-

region of interest), korisno je koristiti ROI Manager (Slika 3). 
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Slika 3. Označena područja istraživanja na krznu risa pomoću programa imageJ 

 

 

Izračunata je površina svakog pojedinog područja. 

komanda: Analyze->Measure 

Izabrana su tamna područja na krznu (točke na krznu). 

komanda: Image->Adjust->Treshold (Slika 4). 
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Slika 4. Izabrana tamna područja na krznu risa pomoću imageJ programa. 

 

 

Izračunata je površina označenih tamnih područja (točaka) za svako područje 

pojedinačno (prednja noga, trup, stražnja noga). 

komanda: Analyze->Measure (Slika 5). 

Izračunati su i ostali parametri (broj tamnih područja, postotaka tamnih područja u 

odnosu na svjetle, gustoća tamnih područja) označenih tamnih područja (točaka) za svako 

područje pojedinačno i to s postavkama da pojedino crno područje (točka) ne može biti manje 

od 50 piksela i time je isključeno mjerenje smetnji i pogrešaka na fotografiji. 

komanda:Analyze->Analyze Particles, size staviti 50-Infinity (Slika 5). 
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Slika 5. Izračunavanje različitih parametara tamnih područja (točaka) na risjem krznu 

upotrebom imageJ programa. 

 

 

Dobiveni rezultati su statistički obrađeni u programu MS Excel 2007 tako da je za 

svako područje i jednu stranu krzna određena srednja vrijednost i standardna devijacija udjela 

crnih površina, broja točaka, gustoće točaka (Tablica 2). 
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Rezultati 

Krzno Tipa 1 je u Hrvatskoj populaciji bilo zastupljeno u 41 jedinke risa, što je 43% u 

odnosu na skupni uzorak (95 jedinki). Krzno tipa 2 bilo je zastupljeno u 16 jedinki (17%). 

Krzna ukupno 15 jedinki risa (16%) svrstana su u kategoriju krzna tip 3, dok je 21 (22%) 

krzno pripalo kategoriji tipa 4 (Slika 6). 

 

 

Slika 6. Usporedni prikaz zastupljenosti pojedinih tipova krzna u populaciji risa u Hrvatskoj. 

 

Kod mladih risova (do 4 godine) od kojih je ukupno potjecalo 5 uzoraka, krzno tipa 3 

je zabilježeno u 2 slučaja, dok je za svaki od preostala tri tipa krzna zabilježen po jedan slučaj. 

Kod risova koji su svrstani u srednju dobnu kategoriju (12 jedinki) zabilježena su četiri krzna 

tipa 1, po tri krzna tipa 2 i tipa 3, te dva krzna tipa 4. U starosnoj dobnoj skupini od ukupno 7 

uzoraka krzna, njih 4 je pripadalo tipu 1, jedno krzno tipu 2, dva krzna tipu 3, dok tip 4 kod 

ove dobne skupine nije zabilježen (Slika 7).  
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Slika 7. Usporedni prikaz zastupljenosti pojedinih tipova krzna po dobnim skupinama. 

 

 

U istraživanoj populaciji risa najzastupljenije je bilo krzno tipa 1 (43%), kao i kod 

slovačke (60%) i jurske (78%) populacije, dok je kod alpske populacije tip 1 bio zastupljen u 

35% slučajeva. Krzno tipa 2 kod istraživane populacije opisano je u 17% slučajeva, dok je 

kod slovačke populacije opisano u 9%, alpske 11% i jurske u 2% slučajeva. Krzno tipa 3 u 

hrvatskoj populaciji bilo je zastupljeno u 16% riseva, u slovačkoj 4%, alpskoj 8% dok u 

jurskoj ovaj tip krzna nije opisan. U istraživanoj populaciji kod 23% jedinki zabilježeno je 

krzno tipa 4, u slovačkoj populaciji 28%, alpskoj 46%, jurskoj 20% (Opisani rezultati za 

slovačku, alpsku i jursku populaciju, preuzeti su iz THULLER, 2002.) (Slika 8, Tablica 1). 
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Slika 8. Usporedni prikaz zastupljenosti pojedinih tipova krzna u populaciji risa u Hrvatskoj, 

populaciji u Slovačkoj, te dvjema populacijama u Švicarskoj 

 

 

 

 

 

Tablica 1. Zastupljenost pojedinih tipova krzna Euroazijskog risa u različitim područjima 

svijeta. 

 

Područje Autor Tip1 Tip2 Tip3 Tip4 

Hrvatska ovo istraživanje 43,0% 17,0% 16,0% 22,0% 

Hrvatska/Slovenija Thuller (2002) 66,0% 6,0% 10,0% 18,0% 

Karpati Thuller (2002) 60,0% 9,0% 4,0% 28,0% 

 Stollmann (1963) 90%    

 Kunc (1971) 67,7% 22,6% 9,7%  

Jura (Švicarska) Thuller (2002) 78,0% 2,0% 0,0% 20,0% 

Alpe (Švicarska) Thuller (2002) 35,0% 11,0% 8,0% 46,0% 

Balkan Mirić (1978)   31,8%  

Kavkaz  33,0%  14,0%  

Zapadni Sibir  17,0% 3,0% 60,0% 20,0% 

Sjeveroistočni Sibir Kistschinski (1967) 22,2% 77,8%   

Tienschan-Saur (Kazahstan)  10,0%  65,0%  

Središnja Azija    27,0% 73,0% 
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Nakon rezultata dobivenih subjektivnim kategoriziranjem krzna na osnovu uzoraka, 

napravljena je obrada fotografija u računalnom programu ImageJ (SCHNEIDER i sur., 

2012.). Rezultati za udio tamnih površina, broj i gustoću točaka, te raspodjelu po određenim 

područjima (prednja noga, stražnja noga, trup) prikazani su u Tablici 2.  
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Tablica 2. Prikaz udjela tamnih površina, broja točaka, gustoće točaka kod različitih tipova krzna risa iz Hrvatske 

 

 tip 1, N=36 tip 2, N=15 tip 3, N=13 tip 4, N=15 sve, N=79 

 Sred. vrij. SD Sred. vrij. SD Sred. vrij. SD Sred. vrij. SD Sred. vrij. SD 

Udio crnih površina 1 (%) 12,24 3,42 9,48 4,23 1,12 0,93 12,25 5,86 9,89 5,59 

Udio crnih površina 2 (%) 8,85 2,29 7,80 2,51 0,40 0,43 7,23 3,84 6,95 3,89 

Udio crnih površina 3 (%) 13,28 4,23 14,23 3,84 1,90 2,15 13,53 5,39 11,63 5,97 

Udio crnih površina ukupno (%) 11,46 2,33 10,50 2,48 1,14 0,85 11,00 3,77 9,49 4,50 

Broj točaka 1 43,06 10,62 39,67 13,30 3,77 3,96 44,00 13,75 36,13 18,16 

Broj točaka 2 37,17 7,71 32,13 8,72 1,38 2,47 30,67 15,93 29,09 15,72 

Broj točaka 3 50,53 10,26 51,73 6,90 11,23 13,60 58,47 14,08 45,80 19,16 

Broj točaka ukupno 130,75 22,41 123,53 18,19 16,38 15,12 133,13 36,89 111,01 48,59 

Gustoća točaka 1 

(broj točaka/površini) 
0,44 0,12 0,39 0,09 0,04 0,04 0,45 0,13 0,37 0,18 

Gustoća točaka 2 

(broj točaka/površini) 
0,26 0,05 0,28 0,07 0,01 0,02 0,25 0,12 0,22 0,12 

Gustoća točaka 3 

(broj točaka/površini) 
0,45 0,11 0,52 0,08 0,11 0,13 0,56 0,12 0,43 0,18 

Gustoća točaka ukupno 

(broj točaka/površini) 
0,38 0,09 0,39 0,08 0,05 0,06 0,42 0,12 0,34 0,16 

 

1 - prednja noga, 2 - trup, 3 - stražnja noga 

(broj točaka / površini) - površina je definirana u Materijalima i metodama 
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Kod krzna tip 1 zabilježena je najveća ukupna površina tamnih područja (točaka), 

zatim kod krzna tip 2 pa tip 4, dok je površina tamnih područja kod krzna tip 3 bila najmanja 

(Slika 9). 

 

 

Slika 9. Udio crnih područja (točaka) na različitim tipovima krzna risa po područjima - tip 1 

(velike točke), tip 2 (male točke), tip 3 (bez točaka), tip 4 (rozeta) 

 

 

Kod sva četiri tipa krzna gustoća tamnih područja (točaka) je bila najveća na području 

stražnje, zatim na području prednje noge, dok je u području trupa gustoća točaka bila 

najmanja (Slika 10).  

 

 

 



15 
 

 

Slika 10. Gustoća tamnih područja (točaka) po razmještaju na tijelu na različitim tipovima 

risjih krzna - tip 1 (velike točke), tip 2 (male točke), tip 3 (bez točaka), tip 4 (rozeta) 

 

 

 

 

Rasprava 

Nekoliko autora kroz povijest je opisalo raznolikost krzna kod euroazijskog risa. Svi 

autori opisuju dva osnovna tipa krzna: krzno s izraženim uzorcima u vidu pjega, te krzno bez 

vidljivih uzoraka (OGNEV, 1935; STOLLMAN, 1963; VASILU i DECEI, 1964; 

MATJUSCHKIN, 1978; MIRIĆ, 1978; RAGNI i sur., 1993; GREGOROVA, 1997; 

THÜLER, 2002). Uz navedene osnovne tipove krzna neki autori opisuju i krzna s malim i 

velikim pjegama (VASILU i DECEI, 1964; MATJUSCHKIN, 1978; MIRIĆ, 1978; 

GREGOROVA, 1997; THÜLER, 2002), te tip krzna s uzorcima u vidu rozeta 

(GREGOROVA, 1997; THÜLER, 2002). Krzno s rozetama koje podsjeća na krzno leoparda 

prvi put opisuje GREGOROVA (1997), iako je taj tip zabilježen na nekoliko fotografija u 

ranijim istraživanjima, no nije detaljno opisan. S obzirom na karakteristike uzoraka na 

krznima korištenim u ovom istraživanju, upotrijebljena je metoda identična metodi tipizacije 

krzna prema GREGOROVA (1997).  

Kod opisivanja tipova krzna risova u hrvatskoj populaciji nije zabilježen niti jedan 

novi tip u odnosu na istraživanja navedenih autora, s time da nije zabilježen tip krzna s 

„rudimentarnim“ rozetama (prijelazni tip između tipa 2 i tipa 4) kakav opisuje THÜLER 

(2002). Sličnost u tipovima krzna risa istraživane hrvatske populacije s opisima krzna 
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navedenih autora za područja Središnje Rusije, Karpata i Balkana je očekivana, jer bez obzira 

na tako široku rasprostranjenost radi se o istoj životinjskoj vrsti. Iako su postojale namjere da 

sa na osnovu morfoloških obilježja te učestalosti određenih tipova krzna balkanski ris izdvoji 

u novu podvrstu, zbog kako smatra MIRIĆ (1978) znatnijeg udjela krzna tipa 3 (jednolično) u 

navedenoj populaciji. 

Nisu pronađene sličnosti u zastupljenosti pojedinog tipa krzna ispitivane populacije u 

odnosu na srodnu karpatsku populaciju (Tablica 1). Uzrok ovome može biti posljedica 

"osnivačkog učinka" kroz koji je prošla hrvatska populacija. Isto se moglo ustvrditi i 

usporedbom zastupljenosti pojedinih tipova krzna hrvatske populacije risa u odnosu na dvije 

švicarske populacije (Jura, Alpe). Poznato je da kod nekih vrsta mačaka (Felis colocolo) 

postoji razlika u tipu krzna s obzirom na prostorni raspored (različita staništa (GARCIA-

PEREA, 1994)). Kod euroazijskog risa također postoje varijacije u tipovima krzna u odnosu 

na različite prostore prebivanja, te kroz određenje vremenske periode (THÜLER, 2002). Kod 

karpatske populacije STOLLMANN (1963) opisuje 90% jedinki s krznom tipa 1, KUNC 

(1971), opisuje 67% jedinki s istim tipom, dok THULLER (2002) opisuje 60% jedinki koje 

pripadaju tipu 1. Navedeno pokazuje da se kroz duže vrijeme učestalost pojedinog tipa krzna 

može značajno mijenjati.  

U Hrvatsku je ris reintroduciran 1973. godine te se zastupljenost pojedinih tipova do 

danas mogla mijenjati pod utjecajem novog životnog prostora. Također je moguće 

pretpostaviti da je zbog smanjene genske raznolikosti kod navedene reintroducirane 

populacije (SINDIČIĆ i sur., 2013) moguća različita raspodjela pojedinih tipova krzna unutar 

populacije u odnosu na populaciju iz koje je potekla (karpatsku populaciju). Ako se uzme u 

obzir da je ris jedna od najraširenijih vrsta mačaka (NOWELL i JACKSSON, 1996), može se 

zaključiti da su staništa risa jako različita. Iz navedene činjenice razumljivo je da se 

evolucijski moglo doći do varijacija u tipu krzna i učestalosti određenog tipa krzna za neka 

staništa, što objašnjava veliku varijabilnost zastupljenosti pojedinih tipova krzna u različitim 

područjima (Tablica 1).  

Iz zastupljenosti pojedinih tipova krzna po dobi životinja moglo bi se naslutiti da se 

udio krzna tipa 1 povećavao sa dobi životinja. Tako je taj tip najučestaliji u srednjem dobnom 

razdoblju (4 do 8 godina) i starosnom dobnom razdoblju (od 8 godina na dalje), dok je kod 

mladih (do 4 godine) najzastupljeniji tip 3 (Slika 7). Iz ovog se može naslutiti teorija o 

povećavanju pjegavosti sa starenjem životinje, koja se spominje u lovačkim krugovima. No 

ovakav rezultat može poslužiti samo kao pretpostavka jer je analiza napravljena na vrlo 

malom uzorku životinja za koje je određena životna dob. 
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Obradom rezultata u računalnom programu ImageJ (SCHNEIDER i sur., 2012) 

utvrđen je najveći udio tamnih područja (točaka) kod krzna tipa 1 (11,46%). Krzno tipa 2 

(10,50% tamnih područja) je imalo veći udio tamnih dijelova samo u području stražnje noge, 

što je za očekivati s obzirom na izračunatu daleko veću brojnost i gustoću točaka navedenog 

područja kod ovoga tipa krzna (Tablica 2). Krzno tipa 4 je na dva područja (prednja i stražnja 

noga) imalo neznatno veći udio tamnih površina, ali značajnije manji udio na području trupa, 

čime je imalo i manji udjel ukupne tamne površine (11%). Na području trupa kod krzna tip 4 

su uzorci u obliku rozeta, koje su nerijetko slabo istaknute, dok se na ekstremitetima javljaju 

jasne upečatljive pjege (THÜLER, 2002), što je i uzrok ovakve raspodjele. Krzno tipa 3 je 

očekivano imalo najmanji udio površine zahvaćene točkama, s tim da je područje stražnjih 

nogu imalo značajno veći udio tamne površine od područja prednjih nogu i trupa. Istu 

raspodjelu točaka kod ovog tipa opisuje i MATJUSCHKIN (1978). Broj točaka je u velikoj 

mjeri bio u korelaciji s udjelom tamnih područja (veći udio tamnih područja - veći broj 

točaka). Izuzetak je područje stražnjih nogu kod krzna tipa 2 jer je zbog manjih točaka bez 

obzira na brojnost imalo manji udio tamnog područja u odnosu na isto područje kod krzna tip 

4. Gustoća točaka je općenito bila najveća na području stražnjih nogu, dok je najmanja 

gustoća bila zabilježena u području trupa kod svih tipova krzna. 
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Zaključci 

1. Krzno kod risa u Hrvatskoj javlja se u četiri osnovna tipa: krzno s velikim pjegama 

(točkama), krzno s malim pjegama, krzno s rozetama, te jednolično krzno bez uzoraka. 

2. Različite fenotipske varijante krzna koje se javljaju nisu usko vezane za određene 

dobne kategorije. 

3. Kod reintroduciranog hrvatskog risa raspodjela tipova krzna je različita i neovisna u 

odnosu na karpatsku populaciju, zbog smanjene genske raznolikosti i izoliranosti 

navedene populacije 

4. Kod sva četiri tipa krzna uzorci su najbrojniji na području stražnje noge, dok su na 

području trupa najmanje zastupljeni. 

5. Nova kompjutorska metoda je primjenjiva i učinkovita pri određivanju svojstava 

krzna, te njegovu svrstavanju u određene tipove. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



19 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Zahvale 

 

Zahvaljujem se dipl. inž. Alojziju Frkoviću na ustupljenom dijelu dijapozitiva krzna, 

te svim lovnicima i lovcima koji su nam nesebično omogućili fotografiranje krzna u lovačkim 

i planinarskim domovima, te njihovim domaćinstvima. Posebno se zahvaljujem doc. dr. sc. 

Tomislavu Gomerčiću i dr. sc. Magdi Sindičić za ustupljene fotografije, stručno vodstvo, 

strpljenje i pomoć u izradi ovog rada. 

 

 



20 
 

Literatura 

GARCIA-PEREA, R. (1994): Pampas cats: how many species? Cat News. 20, 21-24. 

GARMS, H (1981): Fauna Evrope. Mladinska knjiga, Ljubljana. Str. 52-62. 

GOMERČIĆ, T. (2004): Kraniometrijske i druge značajke populacije euroazijskog risa (Lynx 

lynx) u Hrvatskoj. Magistarski rad. Prirodoslovno-matematički fakultet, Sveučilište u 

Zagrebu, Zagreb. 1-65. 

GOMERČIĆ, T. (2010): Morfometrijska obilježja populacije. U: Plan upravljanja risom u 

Republici Hrvatskoj. (Sindičić, M., A. Štrbenac, P. Oković, Ur.) Tiskara Zelina d.d. 

Str. 16. 

GREGOROVA, E. (1997): Lynx. Disertacija. Zoological garden Bojnice. Bojnice, Slovačka. 

HEMMER, V. H. (1993): Felis (Lynx) lynx Linnaeus, 1758- Luchs, Nordluchs U: Handbuch 

der Saugetiere Europas. (Niethammer, J. F. Krapp, Ur.) Aula- Verlag, Wiesbaden. 

Str. 1119-1167. 

KISTSCHINSKI, A. A. (1967): Zur Verbreitung und intraspezifischen Variation des Wolfs, 

Vielfrasses und Luchses auf dem Kolyma-Plateau und im Kolyma-Gebirge. U: 

Ekologija mlekopitajuschich i ptic., Moskau. Str. 10-16. 

KUNC, L. (1971): Individualni variabilita zbarveni rysa ostrovida (Lynx lynx) Karpatske 

oblasti. Lynx n. s. 12, 60-65. 

MATJUSCHKIN, E. N. (1978): Der Luchs. A. Ziemsen Verlag, Wittenberg Lutherstadt, 

Germany. Str. 160. 

MIRIĆ, Đ. (1978): Lynx lynx martinoi ssp. nova (Carnivora, Mammalia) - Nova podvrsta risa 

sa Balkanskog poluostrva. Glasnik prirodnjačkog muzeja. 33, 29-36. 

OGNEV, S. L. (1935): Mammals of USSR and adjacent countries. Carnivora. 3, 165-186. 

RAGNI, B., M. POSSENTI, S. MAYR (1993): The Lynx in the Italian Alps. Cat News. 19, 

21-25. 

RAVEN, P. H., G. B. JOHNSON, J. B. LOSOS, S. R. SINGER (2005): Biology. Mc Graw- 

Hill, New York. Str. 436-442. 



21 
 

SCHNEIDER, C.A., W. S. RASBAND, K. W. ELICEIRI (2012): NIH Image to ImageJ: 25 

years of image analysis. Nature Methods 9, 671-675. 

SINDIČIĆ, M. (2010): Ugroženost risova. U: Plan upravljanja risom u Republici Hrvatskoj. 

(Sindičić, M., A. Štrbenac, P. Oković, Ur.) Tiskara Zelina d.d. Str. 22-23. 

SINDIČIĆ, M., P. POLANC,T. GOMERČIĆ, M. JELENČIĆ, Đ. HUBER, P TRONTELJ, T 

SKRBNIŠEK (2013): Genetic data confirm critical status of the reintroduced Dinaric 

population of Eurasian lynx.Conservation genetics. 14, 1009-1018. 

STOLLMANN, A. (1963): Beitrag zur Kenntnis des Luchses, Lynx lynx in den 

tschechoslowakischen Karpaten. Folia Zoologica. 12, 301-316. 

THÜLER, K. (2001): Spatial and Temporal Distribution of Coat Patterns of Eurasian Lynx 

(Lynx lynx) in two Re-introduced Populations in Switzerland. Diplomski rad. Faculty 

of Science of the University of Bern. Bern, Švicarska. 

VASILIU, G. D., P. DECEI (1964): Über den Luchs (Lynx lynx) der rumӓnischen Karpaten. 

Sӓugetierkundliche Miteilungen. 12, 155-183. 

WEIGEL, I. (1961): Das Fellmuster der wildlebenden Katzenarten und drr Hauskatze in 

vergleichender und stammesgeschichtlicher Hinsicht. Disertacija. Saugetierkundliche 

Mitteilungen Munchen. Munchen, Njemačka. 

WERDELIN, L., L. OLSSON (1997): How the Leopard got its spots: a phylogenetic view of 

the evolution of felid coat patterns. Biological Journal of the Linnean Society. 62, 

383-400. 



22 
 

Obilježja krzna risa (Lynx lynx)  iz Hrvatske 

Tomislav Spajić 

Veterinarski fakultet sveučilišta u Zagrebu, Zagreb, Hrvatska 

 

 

SPAJIĆ, T.: Obilježja krzna risa (Lynx lynx)  iz Hrvatske. Diplomski rad 

 

 

Sažetak 

Euroazijski ris (Lynx lynx) reintroduciran je u Sloveniju i Hrvatsku 1973. godine sa 

slovačkih Karpata. Veličina današnje populacija risa u Hrvatskoj se procjenjuje na 30 do 

60 jedinki. Kod risa se uzorci na krznu mogu javljati u obliku pjega i rozeta, prema čemu 

je 95 obrađenih fotografija krzna svrstano u četiri tipa: krzno s velikim točkama, malim 

točkama, rozetasto krzno te jednolično krzno bez uzoraka. Zastupljenost pojedinog tipa 

krzna nije bila specifična za određene dobne skupine. Usporedbom rezultata istraživane 

populacije s podatcima za karpatsku (izvorne) populaciju zaključeno je da ne postoji 

povezanost u raspodjeli tipova krzna, čemu je pridonijela smanjena genska raznolikost 

hrvatske populacije, te činjenica da se ista razvijala izolirano u posebnom staništu. 

Objektivnom metodom u računalnom programu dobiven je broj, gustoća i raspored točaka 

na krznu, iz čega je zaključeno da je kod svih tipova područje stražnje noge najbogatije 

uzorcima dok su na trupu manje zastupljeni. Dobiveni rezultati bili su u sukladnosti s 

podatcima ostalih autora, koji su rezultate dobivali subjektivnom metodom promatranja i 

prebrojavanja uzoraka 

 

Ključne riječi: ris; Lynx lynx, krzno, genski otklon, Hrvatska. 
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SPAJIĆ, T.: Features of fur of Eurasian lynx (Lynx lynx) from Croatia 

 

 

Abstract 

Eurasian lynx (Lynx lynx) was reintroduced to Slovenia and Croatia in 1973 from the 

Slovakian Carpathian Mountains. Today lynx population in Croatia is estimated at 30 to 

60 individuals. Lynx fur is characterized by spots and rosettes, while 95 photographs of 

lynx fur analyzed in this research were divided into four categories: fur with large spots, 

small spots, fur with rosettes and uniformed fur without any pattern. Frequency of each 

type of fur was not specific for any age group. There is no similarity among the frequency 

of fur patterns in lynx from Croatia and Carpathian lynx population, probably as a result 

of lower genetic variability of Croatian lynx population and the fact that these two 

populations evolved in separate habitats. Number, density and spot pattern for each lynx 

fur were analyzed with software. Results revealed that hind legs had the highest frequency 

of spots in each fur category. This is according to results gained by other authors which 

used subjective methods and analyzed the furs by themselves not buy using computer 

programs.  

 

Key words: lynx, Lynx lynx, fur, genetic drift, Croatia 

 

 


